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This document is based on information available at the time of its publication.  While efforts 

have been made to ensure the contents of this manual are accurate, the information 

contained herein does not purport to cover all specific details or variations in hardware, or 

to provide for every possible contingency in connection with installation, operation, or 

maintenance.  Features may be described herein which are not present in all hardware and 

software systems. Precision Valve and Automation, Inc.  assumes no obligation of notice to 

holders of this document with respect to changes subsequently made. 

Precision Valve and Automation, Inc. makes no representation or warranty, expressed, 

implied, or statutory with respect to, and assumes no responsibility for the accuracy, 

completeness, sufficiency, or usefulness of the information contained herein.  No warranties 

of merchantability or fitness for purpose shall apply. 

This document, including the information contained herein, is the property of 

Precision Valve and Automation, Inc. and is considered confidential and proprietary 

information.  It is delivered on the express condition that it not be used, disclosed, or 

reproduced, in whole or in part, for any reason without prior written consent of 

Precision Valve and Automation, Inc.  

 

Copyright © 2022 

Precision Valve and Automation, Inc. 

All Rights Reserved. 
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  Introduction 
Before you operate this system, read the operation and setup manual. This will help you to 
become familiar with the product and ensure successful operation. 

If any questions or problems arise, contact PVA’s Technical Support department. 

 

1.1 PVA Contact Information 

Main Office   PVA Med 

   Six Corporate Drive  

   Halfmoon, NY 12065 

   Tel +1-518-371-2684 

   Fax +1-518-371-2688 

   Website: https://pvamed.net 

    Email: med@pva.net 

Technical Support  

Tel +1-844-734-0209 

   Email: cs@pva.net 

 

1.2 Document History 

Revision Revision Date Reason for Changes 
REV B September 2022 Workflow Replaced with Mandrel Template Workflow 
REV A June 2022 Initial Release 

 

Note: All photographs and CAD model representations in this document are a 
“general representation” of the system and its components. The actual appearance 
of the system and its components can differ based upon customer specific 
configuration. 

 

 

https://pvamed.net/
https://pvamed.net/
mailto:med@pva.net
mailto:cs@pva.net


 
Carver PRO-S™ Manual 

 

Revision B / September 2022 Page 6 of 67 

 
 

1.3 Safety 

Certain warning symbols are affixed to the machine and correspond to notations in this 
manual. Before operating the system, identify these warning labels and read the notices 
described below. Not all labels may be used on any specific system. 

 

Always wear approved safety glasses when you operate or work near the 
workcell. 

 

Before you operate the system, read and understand the manuals provided 
with the unit. 

 

Never put hands or tools in areas with this symbol when the machine is in 
operation. A dangerous condition may exist. 

 

Read and understand the manuals provided with the unit before any repairs 
or maintenance is done. Only a qualified individual should do service. 

 

Use caution when there are pressurized vessels. Find and repair any leaks 
immediately. Always wear appropriate safety equipment when you work 
with pressurized vessels or vessels that contain chemicals 

 

Shear hazard from moving parts. Avoid contact. 

 

Do not remove protective guarding. 

 

In situations where inattention could cause either personal injury or damage 
to equipment, a warning notice is used. 
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Do not smoke near the machine. Always have a fire extinguisher available 
for emergency use. 

 

Before performing any repairs or maintenance to the system, turn off power 
and lock out the power disconnect switch. 

 

Warning notices are used to emphasize that hazardous voltages, current, 
temperatures, or other conditions that could cause personal injury exist in 
this equipment or may be associated with its use. Only qualified personnel 
should enter areas designated with this symbol. 

 

Laser light source present. Do not stare directly into the beam. Do not use in 
the presence of highly reflective surfaces 

 

Pinch hazard from moving parts. Avoid contact. 

 

Hot surface. Avoid contact. 

 

Warning, Ultraviolet (UV) light hazard. Do not look directly at the UV light 
source. 

 

This product meets EU standards for health, safety, and environmental 
protection. 

 

Warning, no open flames. 

 

Electrostatic sensitive device warning. Observe precautions for handling. 

 



 
Carver PRO-S™ Manual 

 

Revision B / September 2022 Page 8 of 67 

 
 

  Getting Started 
 

2.1 Unboxing 

1. Remove the packaging straps from the shipping crate. 

2. Open the shipping crate by first taking the lid off and then removing the sides. 

3. Remove the plastic wrapping around the metal ramp and any additional items. 

 

Figure 1: Remove Plastic Wrapping 

 

4. Remove the waste bin access key tied to the handle on the front. Open the waste 
bin access doors on the front of the machine and remove the lag screws in the four 
metal brackets that are holding the carver in place around its wheels on the pallet. 

 

Figure 2: Metal Brackets Inside Access Doors 
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5. Secure the metal ramp to the wooden pallet on the side of the carver with the lag 
screws from the previous step. 

 

Figure 3: Metal Ramp Secured to the Wooden Pallet 

 

6. Unload the carver using the metal ramp with at least two people – one person in 
front of the machine and one person behind the machine. 

 

Figure 4: Unloading the Carver Using the Metal Ramp 
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7. Move the carver to its desired location and position the machine on level ground. 

8. To level the carver, lower the feet by turning the red knob on each leg to stabilize it. 
Turning the knob to the left lowers the foot and turning the knob to the right raises 
the foot.  

 

Figure 5: Raise and Lower the Feet 
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2.2 Initial Setup 

 Tool Kit 

Before starting the setup process, locate the Tool Kit that has been provided with your 
Carver PRO-S™. The following items are included and shown below.  

 

Figure 6: Carver Tool Kit 

 

1. Toolbox   5. Mallet 
2. Square Chuck Key  6. microSD Card and Converter 
3. Crescent Wrench  7. Cleaning Brush 
4. Collet Wrench  
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 Mandrels 

One long through mandrel and one short mandrel are included with the Carver PRO-S™. 
Dimensions for both mandrels are as follows: 

• Length of long mandrel: 91.2 cm (35.9 in) in  

• Length of short mandrel: 26.8 cm (10.5 in) in 

• Diameter for both mandrels: 2.5 cm (1 in) 

 

Figure 7: Long Mandrel and Short Mandrel 

 

Refer to Section 7.2 for more information on the PVA Med mandrels. 

 

 Waste Bin Liners 

One (1) roll of clear plastic waste bin liners has been included with the Carver PRO-S™. For 
more information on accessing and emptying the waste bin, refer to Section 5.3. 

 

Figure 8: Roll of Waste Bin Liners 
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 Plugging into Ethernet and Power Connections 

1. Plug one end of the ethernet cable into a wall supply and the other end of the cable 
into the back of the Carver PRO-S™. 

 

Figure 9: Connecting the Ethernet Cable 

 

2. Connect the supplied power cord into the 120/220V wall power supply. Refer to the 
machine serial tag for more information. 

 

Figure 10: Supplied Power Cord End 

 

Note: The unit power is specified at time of purchase depending on outlet 
country. The plug at the end of the cord will reflect these changes. 
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3. Connect the other end of the power cord to the back of the carver. The power 
connection is located directly below the ethernet connection. 

 

Figure 11: Connected Power Cord on Carver PRO-S™ 

 

4. Turn the main power switch on the side of the carver clockwise to the ON position.  

 

 

Figure 12: Main Power Switch 
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 Connecting to the Network 

1. Upon powering up, the machine will be assigned an IP address by the user’s in-
house router. 

2. To view the IP address, select the Setup tab on the bottom right corner of the HMI 
screen. 

 

 

Figure 13: IP Setup Tab Location on the HMI 

 

3. On the bottom left corner in the Setup screen, the IP address that the network has 
assigned to the machine will be shown. 

 

Figure 14: IP Address Location 
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4. This IP address can be entered into an internet browser to access the web interface 
of the carver. Refer to Section 4.2.2 for more information on this interface. 

5. On a new power cycle, the user’s network may assign an alternate IP address based 
on the other devices connected. It is advised to assign a preset static IP address to 
the Carver PRO-S™ to make the connection process easier. Consult any appropriate 
router manual and/or IT group to assign an IP based on the unique MAC address for 
the Carver PRO-S™. 

6. To find the Carver PRO-S™ MAC address, select the Console tab. Enter M540 in the 
terminal and the machine’s MAC address will be displayed. 

Note: If the IP address is displaying as 000.000.00.00, ensure that the front door is 
closed, and the E-stop is disengaged. 

 

Figure 15: MAC Address Location 
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 Cutting Bit Installation 

To install a cutting bit for the first time, or in the event that the cutting bit is damaged, 
worn, or at the incorrect height and needs to be replaced with a new bit, perform the 
following steps: 

1. Place a crescent wrench on the spindle flats, as seen in  Figure 16. 

 

Figure 16: Crescent Wrench Holding the Spindle Flats 

 

2. With the other hand, place a collet wrench on the collet nut, as seen in Figure 17. 

 

Figure 17: Collet Wrench on the Collet Nut 
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3. To prevent the spindle from rotating with the crescent wrench, turn the collet nut to 
the left to loosen the collet until the bit can be fully removed from the collet. 

 

Figure 18: Cutting Bit Removed from Collet 

 

Note: If loosened too much, the bit may fall into the waste bin. 

4. On the HMI, select the Move To Bit Load Position button. 

 

Figure 19: Move to Bit Load Position 
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5. The REMOVE BIT prompt will display. If a bit was previously installed, ensure it has 
been removed and press the OK button to continue. 

 

Figure 20: Remove Bit Prompt 

 

6. The carver will then home and move to the preset position. 

7. A prompt will display indicating to manually install the bit and slide the spindle over 
the mandrel by hand. 

 

Figure 21: Install Bit Prompt 
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8. Place the bit in the collet and manually slide it over to the right side of the mandrel. 
Allow the end of the bit to rest on the mandrel, as seen in Figure 22. 

 

Figure 22: Bit Resting on the Mandrel 

 

9. Secure the spindle with a crescent wrench, tightening the collet with the collet 
wrench until snug. 

10. Once properly tightened, there will be a slight gap between the end of the bit and 
the top of mandrel, as seen in Figure 23. 

 

Figure 23: Gap Between Bit and Mandrel 

 

11. The end of the bit is now at the correct position to run a test carve to confirm 
dimensional accuracy. 
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  DeskProto®  
3.1 Installation and Setup 

1. DeskProto® can be installed by running the DeskProto® Setup program. Users can 
download this setup program (DeskProto71.exe for Windows, DeskProto71.dmg 
for Mac, or DeskProto71.AppImage for Linux) from the download page on the 
DeskProto® website. If installing via a CD, the program is named Setup.exe.  

 

Figure 24: DeskProto® Software Download Page 

 

2. To begin an installation, open DeskProto® 7.1. 

3. On the startup screen, users should select the following: 

a. Machine: ISO plain G-codes – mm 

b. Measurement Unit: mm 

c. Default Project Type: Geometry – most of my files will use 3D files 
(STL/DXF) 
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Figure 25: DeskProto® Startup Screen 

 

4. Click the OK button to apply the selections. 
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 Activating a DeskProto® License 

1. Following the settings startup screen, select the Activate button to begin entering 
the information for a DeskProto® license. 

 

Figure 26: Activating a Current DeskProto® License 

 
2. Copy the company name and key from the license file provided with the machine. 

 

Figure 27: DeskProto® License File 
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3. In the license details section of the activation window, paste the previously copied 
company name in the Name box and the license key in the Key box.  

4. Click the Activate button to activate the license. 

 

Figure 28: Entering a DeskProto® Key to Activate a License 

 
5. Once license activation is complete, the user will be returned to the DeskProto® 

startup screen.   

6. To avoid DeskProto® from displaying the startup screen each time the application is 
opened, uncheck the Show this start screen on startup box. Click the red “X” in 
the upper right-hand corner of the window to apply the change. 
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Figure 29: Turning Off Startup Screen 

 

 Importing Machine Settings 

1. In DeskProto®, navigate to Options -> Library of Machines. 

 

Figure 30: Options Tab 
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2. Click the OK button on the warning screen. Uncheck the Always show this 
message box to avoid the message from showing again. 

 

Figure 31: Machine Library Warning Screen 

 

3. In the Machines Library window, select the Open location button to open a new 
Windows Explorer window. 

 

Figure 32: Open Location in Machine Library 
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4. Upon selecting Open location, a Windows Explorer window will open to the location 
where the DeskProto® machine information was installed and is currently stored. 
The files (deskproto_7-1_settings V1.1, PVA Bit 6in.ctr, PVA CARVER PRO.ppr, 
and PVA CARVER PRO-S.mch) seen in Figure 33 will be copied to this location.  

 

Figure 33: Machine Library Files 

 

Note: These files have been provided with the Carver PRO-S™ license file. They can 
also be downloaded as a zip folder from the PVA Med website on the Carver PRO-S™ 
product page. 

 

5. Close the Windows Explorer window. 

6. In the DeskProto® software, navigate to Options -> Preferences. 

 

Figure 34: Preferences in the Options Tab 
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7. In the Preferences window, navigate to Advanced -> Settings. 

8. Select the Import Settings button. 

 

Figure 35: Advanced Settings Tab 

 

9. Click the YES button on the warning screen to close the project and apply the 
changes. 

 

Figure 36: Import Settings Warning Screen 
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10. Browse to and select the settings file named deskproto_7-1_settings V1.0.xml. 
Click the Open button to import the file into DeskProto®. 

 

Figure 37: Browse to a Settings File 

 

11. A success message will be displayed to confirm that DeskProto® has enabled the 
new settings from the chosen file and the project is properly configured for use. 
Click OK to close the window. 

 

Figure 38: Settings Import Success Message 
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3.2 Workflow Template for Long and Short Mandrels 

 Importing the Template Model 

1. In DeskProto®, open the workflow template by selecting File -> Open Project. 

 

Figure 39: Opening a Project in DeskProto® 

 

2. In the explorer window, browse to the template you would like to import and select 
the Open button. 

 

Figure 40: Choosing a STL file in DeskProto® 

 

3. After the template opens, a second explorer window will open where you will be able 
to select the desired STL file. 

4. To avoid overwriting the template, rename the STL file by selecting File -> Save 
Project As… and entering the desired name. The Project Tree will update the file to 
reflect the new file name. 
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Figure 41: Changing the Name of a Project 

 

 Orienting the Model  

1. After import, the user will see the STL file and a representation of the mandrel. 

 

Figure 42: STL File and Mandrel Representation 

 

2. To orient the model, double-click on the Project Name within the Project Tree. 

 

Figure 43: Project Name Within the Project Tree 
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3. Within the Project Parameters popup, navigate to the Geometry tab. On the 
Geometry tab, select the Transform button. 

 

Figure 44: Geometry Tab in Project Parameters 

 

4. The model will need to be oriented about the X axis. To achieve this, rotate the 
model by 90° or 270° about the Y axis. Select Preview to view changes as they are 
entered. 

 

Figure 45: Geometry Transformation Window 
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5. Use the Translation tool to change the location of the object in mm for X, Y, and Z 
so it is positioned on the mandrel. Use the Preview button to view changes as the 
values are entered. 

 

Figure 46: Translation Tool 

 

6. Before translation and after translation examples are shown below. 

 

Figure 47: Model Before Translation 
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Figure 48: Model After Translation 

 

7. Once positioned, select the OK button in the Geometry Transformation window.  

8. Select OK in the Project Paramater window. 

 

 Define Material Block 

1. To define parameters for the material block, double-click on the part in the Project 
Tree. 

 

Figure 49: Selecting the Part in the Project Tree 

 

2. In the Part Parameters window, navigate to the Material tab. A default material 
size is already set in the template. To modify this size, select the Set Graphically 
button. 

Note: If using a rectangular block, uncheck the “Use cylindrical material block” 
checkbox before proceeding. 
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Figure 50: Material Tab in the Part Parameters Window 

 

3. In the pop-up window, the size of the CAD model will be displayed in Boundaries of 
CAD data section. The size of the material block will be displayed in the Material 
block of current part section.  

 

Figure 51: Setting Material Block Size 
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4. Modify the material block X value so it is the same size or just slightly longer than 
the length of the model displayed as the X value in the Boundaries of CAD data 
section. 

Note: If this value remains at full length, excess time will be spent cutting the right 
side of the material blank rather than parting it off. 

5. If desired, the diameter for a cylindrical block can also be modified in this window by 
entering new values for the XY coordinates. 

6. Width changes for a rectangular block can also be applied in this window by 
entering new values in the Y and Z maximum fields (short mandrel) or X maximum 
field (long mandrel) for the size of the material block. Selecting the Apply button will 
create an appropriately sized rectangle around the part. 

Note: When using a rectangular foam blank, it is important that the Y and Z values are 
entered into the appropriate fields to ensure the material is oriented correctly 
relative to the model. The R field and radius will be automatically calculated. Ensure 
that this number is less than the maximum work area of the Carver PRO-S™. 

7. Select the OK button when finished with changes. Select the OK button in the Part 
Parameter window to return to the main screen. 

 

 Material Block Size Error 

If a material block size is entered that is larger than the work area of the machine, 
DeskProto® will produce a Part Size Error message when selecting the OK button in the 
Material tab of the Part Parameters window. To dismiss this message and return to the 
previous screen to enter new values, select the OK button. 

 

Figure 52: Material Block Size Error 
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 Configuring Cutting Profiles 

1. To configure cutting profiles, double-click on Geometry operation in the Project 
Tree. 

 

Figure 53: Geometry operation in the Project Tree 

 
2. In the Geometry operation window, select the General tab. In the Precision 

section, enter in mm the desired distance between tool paths. The default pitch is 
set to 2.0 mm for the Carver PRO-S™. 

 

 

Figure 54: Adjusting the Distance Between Toolpaths 

 

Note: A smaller distance will create a better finish and finer detail but will result in a 
longer carve. A larger value will create a coarse finish and reduce detail but result in a 
faster carve. 

3. Navigate to the Area tab. Set Area to be machined to Use material block above 
rotation axis. Select the OK button to commit the changes. 
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Figure 55: Use Material Block Above Rotation Axis Selection 

 

Note: If this step is not performed, a Move Outside of Machine Limits error will be 
displayed when the distal end is carved. 

 

 Calculating a Toolpath 

1. Select the Calculate Toolpaths icon. 

 

Figure 56: Calculate Toolpaths Location 

 

2. Once the toolpaths are created, the red lines added in the Model View on the 
DeskProto® home screen will represent the cutting path of the carver. The purple 
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lines shown in the Model View will represent the starting point and the lead in 
process of the carve. 

 

Figure 57:  Model View Showing Cutting Path, Starting Point, and Lead In Process 

 

3. Select OK to close the window. 

 

 Saving a G-code 

Once finished creating all the necessary toolpaths, select the Write NC-program File 
button to save the G-code to the desired location. 

 

Figure 58:  Writing a NC-program File 
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  Operation 
4.1 Preparing for a Carve 

When preparing the Carver PRO-S™ for a carve, the foam blank being used can be either 
inserted onto a pre-installed mandrel or slid onto the mandrel before it is installed into the 
chuck of the machine.  

Below is a list of cylindrical foam blanks options available that are compatible with the 
Carver PRO-S™. 

 Foam Size  
(in) 

Foam Size  
(mm) 

DeskProto® Model 
(mm) 

Cylinder 
X 

(diam) 
Y 

(height) 
X 

(diam) 
Y 

(height) 
R 

(radius) 
X 

(length) 

ISO3.5-612C, 3.5 lb, 6x12 6 12 152 305 76 305 
ISO3.5-812C, 3.5 lb, 8x12 8 12 203 305 102 305 
ISO3.5-816C, 3.5 lb, 8x16* 8 16 203 406 102 406 
ISO3.5-1016C, 3.5 lb, 10x16 10 16 254 406 127 406 
ISO3.5-1018C, 3.5 lb, 10x18 10 18 254 457 127 457 
ISO3.5-1218C, 3.5 lb, 12x18 12 18 305 457 152 457 
ISO3.5-1220C, 3.5 lb, 12x20 12 20 305 508 152 508 
ISO3.5-1224C, 3.5 lb, 12x24 12 24 305 610 152 610 
ISO3.5-1424C, 3.5 lb, 14x24 14 24 356 610 178 610 
ISO3.5-1426C, 3.5lb, 14x26 14 26 356 660 178 660 
ISO3.5-1624C, 3.5 lb, 16x24 16 24 406 610 203 610 
ISO3.5-1626C, 3.5 lb, 16x26 16 26 406 660 203 660 
ISO3.5-1824C, 3.5 lb, 18x24 18 24 457 610 229 610 
ISO3.5-1826C, 3.5lb, 18x26 18 26 457 660 229 660 
Carver PRO-S™ Maximum Work Area 
 19 26 483 660 241 660 

Figure 59: Cylinder Foam Blanks Available 

 

*Note: One (1) box of ISO3.5-816C, 3.5 lb, 8x16 cylinder foam is included with each 
Carver PRO-S™. 
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 Adding a Foam Blank onto a Pre-Installed Mandrel 

1. Align the foam blank’s pilot hole with the end of the pre-inserted mandrel. 

 

Figure 60:  Inserting the Mandrel into a Foam Blank 

 

2. Gently tap end of the foam blank with the mallet from the supplied kit or by hand 
until the mandrel is fully inserted.  

 

Figure 61:  Tapping the Foam Blank with a Mallet 
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3. When fully and properly inserted, the fins on the mandrel should be flush with the 
end of the foam blank. Refer to Figure 68. 

4. Ensure the mandrel is properly installed by confirming the engraved line at the left 
side of the mandrel is flush with the end of the chuck, as seen in Figure 68. To avoid 
movement on the rotation axis, confirm the mandrel has been installed straight. 

 

Figure 62:  Properly Inserted Foam Blank and Mandrel 

 

5. Tighten the chuck with the supplied square chuck key. Once the chuck is fully 
tightened, ensure the square key is removed from machine before operation. 

 

Figure 63: Tightening the Chuck 

 

6. Close the door of the Carver PRO-S™. 
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 Adding a Foam Blank to a Mandrel Before Installation 

1. To ensure the foam blank is slid to the end of the mandrel and fully seated, the user 
can tap the end of the foam blank by hand or with a mallet. 

 

Figure 64: Inserting the Mandrel into a Foam Blank with a Mallet 

 

2. Install the mandrel with the pre-inserted foam blank into the chuck of the Carver 
PRO-S™. The mandrel is properly installed when the engraved line at the left side of 
the mandrel is flush with the end of the chuck. Refer to Figure 71. 

 

Figure 65: Proper Installation of the Mandrel in the Chuck 
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3. Tighten the chuck with the supplied square chuck key. Once the chuck is fully 
tightened, ensure the square key is removed from machine before operation. 

 

Figure 66: Tightening the Chuck with Square Key 

 

4. Close the door of the Carver PRO-S™. 

 

4.2 Using G-code Files 

Once a user has acquired their desired G-code, the Carver PRO-S™ allows for G-codes to be 
loaded through either a microSD card or a network upload. 

 Loading a G-code File from a microSD Card 

1. The user will need to copy the desired G-code file from their PC to a microSD card. 

2. To do this, the microSD card may need to be inserted into an adapter. Upon 
insertion, the microSD card will typically show up on the user’s PC as drive D. 

 

Figure 67: microSD Card 
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3. Once the file is successfully copied, the user should remove the microSD card from 
the PC and insert it into the SD card reader located on the front left of the Carver 
PRO-S™. 

Note: The microSD card must be inserted with the metallic contacts facing the 
center of the Carver PRO-S™. 

 

Figure 68: Inserting the MicroSD Card 

 

4. Once the card is loaded, press the microSD card button on the home page of the 
carver’s HMI control screen, as seen in Figure 75. 

 

 

Figure 69: MicroSD Card Button 
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5. In the microSD options screen, press the microSD card icon to switch between the 
onboard SD card (Card 0) and the secondary SD card on the top of the machine 
(Card 1). 

 

Figure 70: MicroSD Options Screen 

 

6. Once the correct microSD card is selected, choose the desired G-code to run from 
the list. 

 

Figure 71: Select G-code 

 

7. Select the Print button to run the G-code and begin the carve. 
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Figure 72: Print Screen for MicroSD Card 

 

 Loading a G-code File from an Internet Upload 

1. Connect to the Carver PRO-S ™ via the web interface, as seen in Figure 79, by typing 
the carver’s IP address into a web browser.  

2. To upload a new file to the web interface, click the Upload & Start button in the 
upper right-hand corner of the web interface home screen. 

 

Figure 73: Carver PRO-S™ Web Interface Home Screen 
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3. When prompted, select the desired G-code to print and click the Open button. 

 

Figure 74: Select G-code and Open 

 

4. Once selected, the interface will begin uploading the G-code file and a status bar 
will show its progress as it is being transmitted over the network to the carver. This 
file will be saved on Card 0, which is the onboard SD card. 

 

Figure 75: Upload Complete 

 

5. After being successfully uploaded, the carver will begin the carving sequence for 
the selected G-code file. 
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 Accessing G-Code Files from the Web Interface 

Accessing G-code files via the web interface in a web browser allows for files to be 
uploaded, downloaded, deleted, and sorted into sub directories.  

Files can be uploaded by browsing for them or by dragging and dropping them onto the 
Upload G Code Files(s) button.  

 

Figure 76: G-code Files in the Web Interface 

 
To display a list of options for each G-code file that is currently uploaded to the web 
interface: 

1. Right-click on the desired G-code file.  

2. From this window, the user can choose to carve the part (Print File), estimate the 
carve path time (Simulate File), or download the G-code file (Download).  

3. Users can also Rename, Delete, or Edit the selected G-code file in this section.  

 

Figure 77: Right Click Options for G-codes in the Web Interface 

 

Note: The file upload functionality in the web interface cannot be used while the 
Carver PRO-S™ is running. 
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4.3 Starting a Carve 

1. After opening the file, the carver will automatically home all axes. 

2. Once the homing process is complete, the spindle will move to the left side of the 
carver with Z axis fully retracted. 

 

Figure 78: Homing Process Completed with Z Axis Fully Retracted 

 

3. A DEFINE THE ORIGIN message will be displayed on the HMI asking the user to 
define the 0 point of the X and U axis. The axis that is currently selected will display 
as an underlined letter in the middle of jogging distances. 

 

Figure 79: User Message to Define 0 Point of X and U Axis 
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4. Using the buttons on the HMI or the web interface, users can jog the axis to move 
the spindle to the starting point for the X and the U axes.  

 

Figure 80: Jogging the X and U Axes on the HMI 

 

5. The spindle should typically be centered over the left most edge of the foam blank.  

 

Figure 81: Spindle Centered Over Left Most Edge 

 



 
Carver PRO-S™ Manual 

 

Revision B / September 2022 Page 52 of 67 

 
 

Note: If the spindle is biased to the left edge of the foam, the material finished part 
will be short. If the spindle is biased to the right edge of the foam, there will be uncut 
material at the left side of the foam blank. 

6. If using a rectangular blank, it will be important to rotate the X and the U axes, so 
the foam blank matches the orientation used in DeskProto®. Only the X and the U 
axis will be offset during this process. If the Z axis is moved, it will not be 
overwritten. 

7. Do not open the door during this process or the current carve will be aborted. 

8. To ensure the carver is moving in the desired direction, consider the following and 
refer to Figure 88: 

a. X axis – the icons would indicate the increment the user is moving closer to 
or further from the left edge of the machine. 

b. Z axis – the icons would indicate the increment the user is moving closer to 
or further from the end of the bit. 

c. U axis – the icons would indicate the increment the user is moving closer to 
or further from the current 0 point. 

 

Figure 82: Axes Diagram 

 
9. After defining the 0 point for X and U axis, select the OK button. The carve will begin 

using the new X and U axis zero point. 
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10. After the sample carve is completed, the spindle will be turned off, the Z axis will 
lower, and the spindle will move to the right side of the machine.   

 

Figure 83: Spindle and Z Axis Locations After a Finished Carve 

 

11. A completion message will be displayed on the HMI that includes the file name and 
total carving time in hours and minutes. 

 

Figure 84: Sample Print Completion Message 
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12. The door of the Carver PRO-S™ can now be opened and the finished carve can be 
removed from the mandrel.  

 

Figure 85: Removing Finished Part from Mandrel 

 

13. Alternatively, the mandrel can be removed with the finished part still attached by 
opening the chuck with the square key. 

 

Figure 86: Removing Finished Part and Mandrel 
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14. Upon completion, the cylindrical extension on the left end of the sample carve 
should measure 75 mm (2.95 in), as seen in Figure 93. 

 

Figure 87: Finished Cylindrical Extension Sample Carve Tolerance 

 

Note: This measurement may fluctuate slightly if the foam becomes compressed. 
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  Cleaning and Maintenance 
5.1 Ball Screw and Linear Guides 

The ball screw and linear guides should be greased along with the fitting on the carriage 
every 100KM or approximately once a month, whichever comes first. 

• Before applying grease, clean any buildup that forms on the ball screw and seals. 

• A lithium-type, soap base, grease (JIS Type 2) should be used. 

Note: Not all carver models have ball screw and linear guides with grease fittings. If a 
grease fitting is not present, apply a small amount of grease to the ball screw and 
linear guide, and move back and forth to distribute the lubricant. 

 

5.2 Cables and Drive Belt 

The cables in the flexible cable carrier and the spindle drive belt should be examined 
quarterly for wear. If either the cables or the drive belt have become worn, replace as 
necessary. 

 

5.3 Waste Bin 

Each Carver PRO-S™ includes a waste bin and a box of replacement waste bags for the bin. 
A key is provided to lock and unlock the enclosure doors to access the waste bin, as seen in 
Figure 94. 

 

Figure 88: Accessing the Waste Bin 
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When the waste bin has reached capacity: 

1. Unlock the doors using the provided key and slide the waste bin out of the 
enclosure.  

 

Figure 89: Removing the Waste Bin From its Enclosure 

 

2. Remove the used bag and replace with a new bag.  

3. Roll the waste bin back into its enclosure.  

4. Close and lock both enclosure doors.  

Note: For safety purposes, ensure the waste bin enclosure doors are always locked 
when not actively accessing the bin. 
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5.4 Best Practices 

• Do not wear loose clothes or jewelry when operating the carver. 

• Do not touch the cutting bit while it is moving.  

• Immediately engage the Emergency Stop button if personnel is in danger.  

• Locate and define all safety labels on and around the carver before turning the 
machine on. 

• Dispose of all used parts and materials in accordance with local laws and 
regulations. 

Safety is a joint responsibility between the OEM and the end-user. All precautions and 
practices should be in accordance with local regulations.  

Do Not: Use incompatible tools, remove door interlocks or bypass safety devices, 
make custom mechanics, or change material from the original design.  
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  Appendix A 
6.1 Carving Terminology 

 

Carve Rate The volume of foam carved per unit of time. 

G-code The file type that the carver will use to carve the model. This file 
contains all the settings and model information needed to create a 
carve. 

 
Carve Speed Defines at which speed (in millimeters/second) the bit moves while 

carving. 

Profile The saved settings applied to the model when carving in DeskProto® 
software. 

DeskProto® DeskProto® is a 3D CAM program. It can import STL files from any 3D 
CAD program, calculate CNC toolpaths, and then write NC program 
files. 
 

Rapid Plaster® PVA Med’s exclusive modification software designed specifically for 
lower extremity prosthetics.  

STL A file type common for 3D models. Has the file extension “.stl”. 
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  Appendix B 
7.1 Carver PRO-S™ Dimensions 

 

Figure 90: Carver PRO-S™ Dimensions 
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7.2 PVA Med Mandrel Dimensions 

 

Figure 91: PVA Med Mandrel Dimensions 
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7.3 Spare Parts Kit 

Item Description Quantity 
1 Contactor 1 
2 Timing Belt, 150 TH, 15 mm 1 
3 Relay 1 
4 Fuse ATDR-12 1 
5 Fuse ATDR-15 1 
6 Sensor, Prox 2mm, Range, NPN 1 
7 GMC 3A Fuse 1 
8 GMD 1A Fuse 1 
9 End Mill, Ball End, 6 LOC, 8 OL 1 
10 Stepper Motor 1 

Figure 92: Spare Parts Kit 

 

7.4 Technical Specifications and Warnings 

• Do not use the Carver PRO-S™ if wires are frayed, connections are loose, or if 
unusual conditions are detected that could indicate a short.  

• This machine is made of machined metal which may retain sharp edges. Improper 
handling may result in property damage or personal injury. 

• Supervise any children who are near or using this product.  

 

  



 
Carver PRO-S™ Manual 

 

Revision B / September 2022 Page 63 of 67 

 
 

  Table of Figures 
Figure 1: Remove Plastic Wrapping ...................................................................................................... 8 
Figure 2: Metal Brackets Inside Access Doors .................................................................................. 8 
Figure 3: Metal Ramp Secured to the Wooden Pallet ........................................................................ 9 
Figure 4: Unloading the Carver Using the Metal Ramp .................................................................... 9 
Figure 5: Raise and Lower the Feet .................................................................................................... 10 
Figure 6: Carver Tool Kit ......................................................................................................................... 11 
Figure 7: Long Mandrel and Short Mandrel ....................................................................................... 12 
Figure 8: Roll of Waste Bin Liners ........................................................................................................ 12 
Figure 9: Connecting the Ethernet Cable .......................................................................................... 13 
Figure 10: Supplied Power Cord End .................................................................................................. 13 
Figure 11: Connected Power Cord on Carver PRO-S™ ..................................................................... 14 
Figure 12: Main Power Switch .............................................................................................................. 14 
Figure 13: IP Setup Tab Location on the HMI .................................................................................... 15 
Figure 14: IP Address Location ............................................................................................................ 15 
Figure 15: MAC Address Location ........................................................................................................ 16 
Figure 16: Crescent Wrench Holding the Spindle Flats................................................................... 17 
Figure 17: Collet Wrench on the Collet Nut ........................................................................................ 17 
Figure 18: Cutting Bit Removed from Collet ..................................................................................... 18 
Figure 19: Move to Bit Load Position ................................................................................................... 18 
Figure 20: Remove Bit Prompt ............................................................................................................. 19 
Figure 21: Install Bit Prompt ................................................................................................................. 19 
Figure 22: Bit Resting on the Mandrel ............................................................................................... 20 
Figure 23: Gap Between Bit and Mandrel ......................................................................................... 20 
Figure 24: DeskProto® Software Download Page........................................................................... 21 
Figure 25: DeskProto® Startup Screen ............................................................................................ 22 
Figure 26: Activating a Current DeskProto® License ................................................................... 23 
Figure 27: DeskProto® License File ................................................................................................... 23 
Figure 28: Entering a DeskProto® Key to Activate a License ..................................................... 24 
Figure 29: Turning Off Startup Screen .............................................................................................. 25 
Figure 30: Options Tab.......................................................................................................................... 25 
Figure 31: Machine Library Warning Screen ..................................................................................... 26 
Figure 32: Open Location in Machine Library .................................................................................. 26 
Figure 33: Machine Library Files .......................................................................................................... 27 
Figure 34: Preferences in the Options Tab ....................................................................................... 27 
Figure 35: Advanced Settings Tab ..................................................................................................... 28 
Figure 36: Import Settings Warning Screen ..................................................................................... 28 
Figure 37: Browse to a Settings File .................................................................................................. 29 
Figure 38: Settings Import Success Message ................................................................................. 29 
Figure 39: Opening a Project in DeskProto® ................................................................................... 30 
Figure 40: Choosing a STL file in DeskProto® ................................................................................ 30 



 
Carver PRO-S™ Manual 

 

Revision B / September 2022 Page 64 of 67 

 
 

Figure 41: Changing the Name of a Project ...................................................................................... 31 
Figure 42: STL File and Mandrel Representation ............................................................................. 31 
Figure 43: Project Name Within the Project Tree ............................................................................ 31 
Figure 44: Geometry Tab in Project Parameters ............................................................................ 32 
Figure 45: Geometry Transformation Window ................................................................................ 32 
Figure 46: Translation Tool .................................................................................................................. 33 
Figure 47: Model Before Translation .................................................................................................. 33 
Figure 48: Model After Translation .................................................................................................... 34 
Figure 49: Selecting the Part in the Project Tree ........................................................................... 34 
Figure 50: Material Tab in the Part Parameters Window ............................................................... 35 
Figure 51: Setting Material Block Size ............................................................................................... 35 
Figure 52: Material Block Size Error ................................................................................................... 36 
Figure 53: Geometry operation in the Project Tree ......................................................................... 37 
Figure 54: Adjusting the Distance Between Toolpaths.................................................................. 37 
Figure 55: Use Material Block Above Rotation Axis Selection ..................................................... 38 
Figure 56: Calculate Toolpaths Location .......................................................................................... 38 
Figure 57:  Model View Showing Cutting Path, Starting Point, and Lead In Process ............. 39 
Figure 58:  Writing a NC-program File ............................................................................................... 39 
Figure 59: Cylinder Foam Blanks Available ...................................................................................... 40 
Figure 60:  Inserting the Mandrel into a Foam Blank ...................................................................... 41 
Figure 61:  Tapping the Foam Blank with a Mallet ........................................................................... 41 
Figure 62:  Properly Inserted Foam Blank and Mandrel ................................................................ 42 
Figure 63: Tightening the Chuck ........................................................................................................ 42 
Figure 64: Inserting the Mandrel into a Foam Blank with a Mallet .............................................. 43 
Figure 65: Proper Installation of the Mandrel in the Chuck .......................................................... 43 
Figure 66: Tightening the Chuck with Square Key ......................................................................... 44 
Figure 67: microSD Card ....................................................................................................................... 44 
Figure 68: Inserting the MicroSD Card .............................................................................................. 45 
Figure 69: MicroSD Card Button ......................................................................................................... 45 
Figure 70: MicroSD Options Screen ................................................................................................... 46 
Figure 71: Select G-code....................................................................................................................... 46 
Figure 72: Print Screen for MicroSD Card ......................................................................................... 47 
Figure 73: Carver PRO-S™ Web Interface Home Screen ............................................................... 47 
Figure 74: Select G-code and Open ................................................................................................... 48 
Figure 75: Upload Complete ................................................................................................................ 48 
Figure 76: G-code Files in the Web Interface ................................................................................... 49 
Figure 77: Right Click Options for G-codes in the Web Interface ................................................ 49 
Figure 78: Homing Process Completed with Z Axis Fully Retracted .......................................... 50 
Figure 79: User Message to Define 0 Point of X and U Axis ......................................................... 50 
Figure 80: Jogging the X and U Axes on the HMI ............................................................................ 51 
Figure 81: Spindle Centered Over Left Most Edge ........................................................................... 51 
Figure 82: Axes Diagram ...................................................................................................................... 52 



 
Carver PRO-S™ Manual 

 

Revision B / September 2022 Page 65 of 67 

 
 

Figure 83: Spindle and Z Axis Locations After a Finished Carve ................................................ 53 
Figure 84: Sample Print Completion Message ................................................................................ 53 
Figure 85: Removing Finished Part from Mandrel .......................................................................... 54 
Figure 86: Removing Finished Part and Mandrel ............................................................................ 54 
Figure 87: Finished Cylindrical Extension Sample Carve Tolerance ........................................... 55 
Figure 88: Accessing the Waste Bin .................................................................................................. 56 
Figure 89: Removing the Waste Bin From its Enclosure ................................................................ 57 
Figure 90: Carver PRO-S™ Dimensions ............................................................................................. 60 
Figure 91: PVA Med Mandrel Dimensions........................................................................................... 61 
Figure 92: Spare Parts Kit .................................................................................................................... 62 
 

  



 
Carver PRO-S™ Manual 

 

Revision B / September 2022 Page 66 of 67 

 
 

  Notes 
 

 

 

 

 

 

 

 

 

 

 

 

 

  



 
Carver PRO-S™ Manual 

 

Revision B / September 2022 Page 67 of 67 

 
 

  Warranty 
PVA Warranty Policy                 

PVA warrants the enclosed product against defects in material or workmanship on all 
components for one year from the date of shipment. 

The warranty does not extend to components damaged due to misuse, negligence, or 
installation and operation that are not in accordance with the recommended factory 
instructions. Unauthorized repair or modification of the enclosed product, and/or the use 
of spare parts not directly obtained from PVA (or from factory authorized dealers) will void 
all warranties. 

All PVA warranties extend only to the original purchaser. Third party warranty claims will 
not be honored at any time. 

Prior to returning a product for a warranty claim, a return authorization must be obtained 
from PVA’s Technical Support department. Authorization will be issued either via the 
telephone, facsimile, or in writing upon your request. 

To qualify as a valid warranty claim, the defective product must be returned to the factory 
during the warranty period. Upon return, PVA will repair (or replace) all components found 
to be defective in material or workmanship. 

 

(Retain this for your records) 

 

Product Information: 

PRODUCT:      ______________________________ 

SERIAL NUMBER:     ______________________________ 

DATE OF PURCHASE:    ______________________________ 
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